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 |Introduction

.Network Traffic Trace .What is Wireshark?

« Arecording of the network « A graphical network packet analyser.
packets both received by and
transmitted from a network

e Found at http://www.wireshark.org

interface. « The complete manual is located here.
.What is a pcap file? .What some are it's uses?
* pcap = Packet Capture « Troubleshoot network problems.

* File format originally designed
1 181 y S  Learn network protocol internals.

for tcpdump/libpcap. « Debug protocol/program implementation.

* Most widely used packet capture Examine network-related security issues.

format.


http://www.wireshark.org/
http://www.wireshark.org/docs/wsug_html_chunked/

Basic Ul

I test.cap M=%

File Edit View Go Capture Analyze Statistics Telephony Tools Internals Help Menu
BUdeM EPEXREE AesdT 2| BEE -y B k| B
Filter: rv I Expression...
Mo, Time Source Destination Protocol /Length |Info |
1 0.000000 192.168.0.2 Broadcast ARP 42 Gratuitous ARP for 192.168.0.2 (Hg
0.2 NENS 92 Name guery NBSTAT *<00><00><00><(

2 0.299139 192.168.0.1 152.168.

025659 192.168. 224.0.0.22 IGMP 54 v3 Membership Report / Jain grouf

4 1. 0.2

51.044366 192.168.0.2 192.168.0.1 DNS 110 standard guery sSRv _ldap._tcp.nbc

6 1.048652 192.168.0.2 239.255.255.250 SSDP 175 EARC

7 1.050784 192.168.0.2 Lo Les. 0.1 DNS S0A nb10061d. wwl0d

8 1.055053 192.168.0.1 192.168.0.2 SSDP 7 oK

9 1.082038 192.168.0.2 192.168.0.255 NBNS istration NB NBLO061D<00>
10 1.111945 192.168.0.2 192.168.0.1 DNS 87 sStandard guery A proxyconf.ww004.
11 1.226156 192.168.0.2 192.168.0.1 TCP 62 ncu-2 > http [SYN] Seq=0 win=6424
12 1.227282 192.168.0.1 192.168.0.2 TCP 60 http > ncu-2 [SYN, ACK] Seq=0 Ack/v

" 111 i \>|

# Frame 11: 62 hytes on wire (496 bits), 62 bytes captured (496 bits)
# Ethernet II, Src: 192.168.0.2 (00:0b:5d:20:cd:02), Dst: Netgear_2d:75:9a (00:09:5b:2d:75:9a)
# Internet Protocol, Src: 192.168.0.2 (192.168.0.2), Dst: 192.168.0.1 (192.168.0.1)
= Transmission Control Protocol, Src¢ Port: ncu-2 (3196), Dst Port: http (80), Seq: 0, Len: O
Source port: ncu-2 (3196) =
pestination port: http (80)
[stream index: 5]
Sequence number: 0 (relative sequence number) -
Header length: 28 hytes PaCket Detalls*
# Flags: 0x02 (SYN) o
window size value: 64240 v

0000 00 09 5b 2d 75 9a 00 Ob 5d 20 cd 02 08 00 45 00 P Dt PererR |
0010 00 30 18 48 40 00 80 06 61 2c c0 a8 00 02 cO a8 .0.H@. .. a,
0020 00 01 0c 7c 00 50 3¢ 36 95 f8 00 00 00 00 70 02 cen | .P<B
0030 fa fO 27 20 00 00 02 04 05 b4 01 01 04 02 .

Packet Bytes

@ | File: "C:jtest.cap” 14 KB 00:00:02 | Packets: 120 Displayed: 120 Marked: 0 Load time: 0:00,000 | Profile: Default




Basic Ul

.File -> Open

View -

View -

>

Opens a packet capture file.

Time Display Format

. Change the format of the packet timestamps in the packet

list pane.

Switch between absolute and relative timestamps.

Change level of precision.

Name Resolution

. Allow wireshark to resolve names from addresses at

different protocol layers.



Basic Ul

.Capture -> Interfaces

. Available network interfaces
for capture.

o lotal packets per interface.

o Packet rate per interface.

.Capture -> Options

« Set various capture parameters.
.Promiscous mode

« On - record all packets reaching the
interface.

« Off - record only those packets directed

to the host.

Device
gleml
#p37p1
&) any
gllo

| @Help '

Wireshark: Capture Interfaces

Description IP

192.168.0.11

Pseudo-device that captures on all interfaces  unkn

127.00.1

Packets Packets/s

‘ @i start || @l Options |
‘ @& Start ] ‘ sl Options ‘
‘ @ start | | @l Options |
| @istart || il Options ‘

‘ X Close [

Wireshark: Capture Options

Capture

Interface: Ieml

IP address: 192.168.0.11, fe80:218:f3ff:fe2e:4256
Link-layer header type: ‘ Ethernet =

M Capture packets in promiscuous mode

[_J Capture packets in pcap-ng format
[CJ Limit each packet to | 6553° bytes

Buffer size: |1 ]:: megabyte(s)

‘ @il Capture Filter: ‘;

v | | Compile BPF

Capture File(s)
File: [ ‘ (iﬁBrowseml

[} Use multiple files

Stop Capture ...

[ ... after
[ .. after

[ ... after

i @HelL‘

Display Options

M Update list of packets in real time
M Automatic scrolling in live capture

M Hide capture info dialog

Name Resolution

M Enable MAC name resolution
[~} Enable network name resolution

(M Enable transport name resolution

\ € Cancel H @ Start !




e Basic Ul

.Analyze -> Follow TCP Stream

e Applies a filter to follow a single tcp conversation within the trace.

e Displays the reassembiled data section of each packet in the conversation.

® Useful for debugging or analyzing any TCP based application layer protocol.

. HTTP, FTP, SSH, LDAP, SMTP, etc.



e Basic Ul

.Statistics -> Protocol Hierarchy

o Presents descriptive
statistics per protocol.

o Useful for determining the
types, amounts, and
relative proportions of
protocols within a trace.

.Statistics -> Conversations

. Generates descriptive
statistics about each
conversation for each
protocol in the trace.

Wireshark: Protoco

L Hierarchy Statistics

Display filter: none

Protocol

V Ethernet

Address Resolution Protocol

3\ |
¥ Logical-Link Control ] | 632[006%]
Spanning Tree Protocol [ o57% | 609 005%]
¥ Cisco Discovery Protocol [ oo2y% | 20| 001 % |
Malformed Packet [ ooy | 20/ 001 % |
Logical-Link Control Basic Format XID [ 000 | 3/000% |
¥ Internet Protocol Version 6 [ os9% | 625[011%]
¥ User Datagram Protocol [ o42% | 4s0/009%|
DHCPV6 [ o20% | 210[004%]
Domain Name Service [ o19% | 204[004%]
Hypertext Transfer Protocol ‘ 003 % t 36.‘ 001 % t
Internet Control Message Protocol vb :‘ 0.16 % [ 1?55‘ 002 % [
¥V Internet Protocol Version 4 M 103013;W7

¥ User Datagram Protocol | 369% | 3912 100% |
Domain Name Service [ 242% | 2573[060% |
Dropbox LAN sync Discovery Protocol ‘ 046 % i 486-‘ 011 % i
Bootstrap Protocol [ o46% | 484|022%]
Common Unix Printing System (CUPS) Browsing Protocol ‘ 0.04 % t 39‘ 001 % t
¥ NetBIOS Datagram Service [ oos% | 55002 % |

V SMB (Server Message Block Protocol) [ oosw | s5/co2%l|-

e —— e ——
| @Help ‘

Ethernet: 214 ‘LI i ha FDDI 1Pv4: 400 | IPv6: 87 TP | TCP: 1325 | Token Ring | UDP:
Ethernet Conversations
Address A Address B Packets Bytes Packets A-=B Bytes A-B
BrocadeC_ef:8b:00 Broadcast 753 59 280 753 59 280
Spanning-tree-(for-bridges) 00 Gsco_ed:4e:59 609 38 976 0 0
Dell.77.19:25 Broadcast 486 29 343 486 29 343
Dell_77:19:25 IPvbmcast_00:01:00:02 16 2352 16 2352
Dell_4524bb Broadcast 2 120 2 120
CadmusCo_e5ac58 Gsco-Li_cl:d1f9 101 328 77 500 345 42 867 5114212
Dell_9e 44 b0 Broadcast 165 26 054 165 26 054
QuantaCo_8f:42:cd Broadcast 40 2 400 40 2 400
Dell_dSc7:3b Broadcast 67 4625 67 4625
IntelCor_3d:19:63 Broadcast 7 420 7 420

e — e —————— e a——in
& Name resolution | Limit to display filter

 @rep fii‘_COPv 7

1374

Packets A«B
ol

609

0

0

0

58 461
0

0
0
0

X Close




Basic Ul

.Statistics -> Flow Graph

Generates a sequence
graph for the selected
traffic.

Useful for understanding

seq. and ack. calculations.

Time

41.552
41.561
41.561
41.561
41.568
41.622
41.622
41.622
41622
41.622
41.622
41.622
41622
41.622
41.622
41623
41623

traffic_trace.pcap

- Graph Analysis

192.168.1.99

173.194.37.52

(50489):—L’S 3 = Etw)
'« SYN, ACK !
50489)* 4(80)
( ACK

{50483) .—"( )

(5o4ag)$H'ACK Len: 2§

(50489)-"—K_: (so)
ACK - Len: 1418

50489)F an)

( ACK 2

(50489 ———*i(a0)

(smﬁacg Len: 1418 o)

(50483 :—L_'ﬁ%o)
(504897 = T(0)

ACK

(50489)i———————*i(an)

ACK - Len: 1418
504 8 )
(50489, ACK ,(80)

(504 89) —"——ﬂao)

(50489) ACK 1(80)
{504 8
P ﬂ, ACK - Len: 1g§
(5048 &0)
ACK

{504 89) ——_"'(m)

Comment

Seq=0
Seq=0Ack=1
Seq=1Ack=1
Seq=1Ack=1

Seq = 1 Ack = 285
Seq =1 Ack = 285
Seq = 285 Ack = 1419
Seq = 1419 Ack = 285

| Seq = 285 Ack = 2837

Seq = 2837 Ack = 285
Seq = 285 Ack = 3537
Seq = 3537 Ack = 285
Seq = 285 Ack = 4955
Seq = 4955 Ack = 285
Seq = 285 Ack = 6373
Seq = 6373 Ack = 285
Seq = 285 Ack = 7633

= =3 i

‘ i Save As ‘

! X Close




* Packet Capture

.Interface selection
- Capture -> Interfaces

. Select the interface from which to capture packets.

- any — captures from all interfaces
* lo — captures from the loopback interface (i.e. from localhost)
. Set the desired capture parameters under the options
menu.

.Start Capture

« Click the start button next to the desired interface.

- Captured traffic will be displayed in the packet list pane.



* Packet Capture

.Stop Capture
- Select Capture -> Stop

.Saving Capture

. Once the capture has been stopped select File - >
Save As.

- From the save dialog you can specify file type and
which packets to save via the packet range
menu.



* Trace Analysis

W test cap

File Edit WVew Go Capture Analyze Statistics Telephony Tools Internals Help

Beoee BEEXR2E Aes T &|EE

Filter: \ v | Expression. ..
Ma. Time Source Destination Protocol |Length |Info
1 0.000000 192.168.0.2 Broadcast ARP 42 Gratuitous ARP for 192.168.0.2 (F=
NBNS 92 mName guery NBSTAT *<00><00><00><(

2 0.299139 192.168.0.1 192.168.0.2

.025659 192.168. 224.0.0.22 IGMP 54 v3 Membership Report / Join groug

41 0.2

51.044366 192.168.0.2 152.168.0.1 DNS 110 standard _query SRV _Tdap._tcp.nbc

6 1.048652 192.168.0.2 239.255.255.250 SSDP 175 EARC S

7 1.050784 152.168.0.2 192.168.0.1 DNS SOA nhl0061d. wwl0d

8 1.055053 152.168.0.1 192.168.0.2 SSDP 7 oK

9 1.082038 192.168.0.2 192.168.0.255 NBNS istration NB NBLO061D<00>
10 1.111945 192.168.0.2 192.168.0.1 DNS 87 Standard guery A proxyconf.ww004.
11 1.226156 192.168.0.2 192.168.0.1 TCP 62 ncu-2 > http [SYN] Seqg=0 win=6424
12 1.227282 192.168.0.1 192.168.0.2 TCP 60 http > ncu-2 [SYN, ACK] Seq=0 Acklv.

i 1) \ [ >

+

| Frame 11: 62 bytes on wire (496 bits), 62 bytes captured (496 bits)

| Ethernet II, Src: 192.168.0.2 (00:0b:5d:20:cd:02), Dst: Netgear_2d:75:9a (00:09:5b:2d:75:9a)

+# Internet Protocol, Sr¢: 192.168.0.2 (192.168.0.2), Dst: 192.168.0.1 (192.168.0.1)

Transmission Control Protocol, Src Port: ncu-2 (3196), Dst Port: http (80), Seq: 0, Len: O '
Source port: ncu-2 (3196) ‘f

+ =+

@

pestination port: http (80)
[stream index: 5]

Sequence number: 0 (relative sequence number) = |

Header Tlength: 28 hytes PaCKet Detalls
# Flags: 0x02 (SynN)

window size value: 64240 v

0000 00 09 S5b 2d 75 9a 00 Ob 5d 20 cd 02 08 00 45 00 P B € Perere |
0010 00 30 18 48 40 00 80 06 61 2c¢ c0 a8 00 02 cO a8 .0.HE. ..
0020 00 01 0c 7c 00 50 3c 36 95 f8 00 00 00 00 70 02 co. | P<B
0030 fa f0O 27 20 00 00 02 04 05 b4 01 01 04 02 I ——

Packet Bytes

@ | File: "C:jtest.cap” 14 KB 00:00:02 | Packets: 120 Displayed: 120 Marked: 0 Load time: 0:00,000 | Profile: Default




* Trace Analysis

.Packet list

Displays all of the packets in the trace in the order they were
recorded.

Columns

- Time — the timestamp at which the packet crossed the
interface.

. Source — the originating host of the packet.
. Destination — the host to which the packet was sent.
. Protocol — the highest level protocol that Wireshark can detect.

. Lenght — the lenght in bytes of the packet on the wire.

- Info — an informational message pertaining to the protocol in
the protocol column.



* Trace Analysis

.Packet list
Default Coloring
- Gray — TCP packets

« Black with red letters — TCP Packets with errors

« Green—HTTP Packets
. Light Blue — UDP Packets

. Pale Blue — ARP Packets
. Lavender — ICMP Packets
- Black with green letters — ICMP Packets with errors

Colorings can be changed under View -> Coloring Rules



* Individual Packet Analysis

W test cap

File Edit WVew Go Capture Analyze Statistics Telephony Tools Internals Help

Beoee BEEXR2E Aes T &|EE

Filter: \ v | Expression. ..
Ma. Time Source Destination Protocol |Length |Info
1 0.000000 192.168.0.2 Broadcast ARP 42 Gratuitous ARP for 192.168.0.2 (F=
NBNS 92 mName guery NBSTAT *<00><00><00><(

2 0.299139 192.168.0.1 192.168.0.2

.025659 192.168. 224.0.0.22 IGMP 54 v3 Membership Report / Join groug

41 0.2

51.044366 192.168.0.2 152.168.0.1 DNS 110 standard _query SRV _Tdap._tcp.nbc

6 1.048652 192.168.0.2 239.255.255.250 SSDP 175 EARC S

7 1.050784 152.168.0.2 192.168.0.1 DNS SOA nhl0061d. wwl0d

8 1.055053 152.168.0.1 192.168.0.2 SSDP 7 oK

9 1.082038 192.168.0.2 192.168.0.255 NBNS istration NB NBLO061D<00>
10 1.111945 192.168.0.2 192.168.0.1 DNS 87 Standard guery A proxyconf.ww004.
11 1.226156 192.168.0.2 192.168.0.1 TCP 62 ncu-2 > http [SYN] Seqg=0 win=6424
12 1.227282 192.168.0.1 192.168.0.2 TCP 60 http > ncu-2 [SYN, ACK] Seq=0 Acklv.

i 1) \ [ >

+

| Frame 11: 62 bytes on wire (496 bits), 62 bytes captured (496 bits)

| Ethernet II, Src: 192.168.0.2 (00:0b:5d:20:cd:02), Dst: Netgear_2d:75:9a (00:09:5b:2d:75:9a)

+# Internet Protocol, Sr¢: 192.168.0.2 (192.168.0.2), Dst: 192.168.0.1 (192.168.0.1)

Transmission Control Protocol, Src Port: ncu-2 (3196), Dst Port: http (80), Seq: 0, Len: O '
Source port: ncu-2 (3196) ‘f

+ =+

@

pestination port: http (80)
[stream index: 5]

Sequence number: 0 (relative sequence number) = |

Header Tlength: 28 hytes PaCKet Detalls
# Flags: 0x02 (SynN)

window size value: 64240 v

0000 00 09 S5b 2d 75 9a 00 Ob 5d 20 cd 02 08 00 45 00 P B € Perere |
0010 00 30 18 48 40 00 80 06 61 2c¢ c0 a8 00 02 cO a8 .0.HE. ..
0020 00 01 0c 7c 00 50 3c 36 95 f8 00 00 00 00 70 02 co. | P<B
0030 fa f0O 27 20 00 00 02 04 05 b4 01 01 04 02 I ——

Packet Bytes

@ | File: "C:jtest.cap” 14 KB 00:00:02 | Packets: 120 Displayed: 120 Marked: 0 Load time: 0:00,000 | Profile: Default




Individual Packet Analysis

.Packet Details

Detailed information about the currently selected packet is
displayed in the packet details pane.

- All packet layers are displayed in the tree menu.

- Any portion of any layer can be exported via a right click and
selecting Export Selected Packet Bytes

.Packet Bytes
Displays the raw packet bytes.

- The selected packet layer is highlighted.



* Filters

Packets captures usually contain many packets irrelevant to
the specific analysis task.

Toremove these packets from display or from the capture
Wireshark provides the ability to create filters.

Filters are evaluted against each individual packet.

Boolean expresions dealing with packet properties.

Supports regular expressions.

Can either be manually constructed, composed via the
Expressions menu or composed based on a selected
packet's properties.



* Filters

.Expressions Menu

. Field name - selects the
packet property.

Wireshark: Filter Expression - Profile: Default

. Field name Relation Value (protocol)
- Relation - selects the ey ey |
P> HP_ERM - HP encapsulated remote mirrori Lt -
boolean test > HPEXT - HP Extended Local-Link Control . valu
: » HPSW - HP Switch Protocol o
. P HPTEAM - HP NIC Teaming Heartbeat ] )
. Predefined values - common > HSRP - Cisco Hot Standby Router Protocol >
V a l. u e S a g a i n S t W h i C h t h e http.notification - Notification (TRUE if = -
. http.response - Response (TRUE if HTT rc:nt ahlns
Selected paCket property ]S http.request - Request (TRUE if HTTP r arches
http.authbasic - Credentials Raniae (off setdenath)
te Sted ° http.request. method - Request Method| ., ‘ L SR
—— > | |
. Value - Arbitrary Textual or (O] ol Qi

Numeric value against
which the selected packet
property is tested.



* Filters

.Compound Filters
Filters can be composed of multiple tests joined with boolean
connectives.
- && - logical conjuction (i.e. AND)
* || - logical disjunction (i.e OR)
- | -|ogical negation (i.e. NOT)
Supports the order of operations.

.Regular Expressions

Fields can be evaluated against a regular expression using the
“matches” test.

Uses Perl regex syntax.



http://www.cs.tut.fi/~jkorpela/perl/regexp.html

* Filters

.Filter Text Box

Green - valid filter
Red - invalid filter
Yellow - may produce unexpected results

.Packet based filters
Filters can be constructed on the basis of individual packets
by right clicking on a packet and selecting either:
- Prepare as filter — creates a filter.
- Apply as filter — creates a filter and applies it to the trace.

- Follow TCP Stream — creates a filter from a TCP packet's
stream number and applies it to the trace.



Filters

.Filter examples
http.request - Display all HTTP requests.

http.request ||http.response - Display all HTTP request and
responses.

. ip.addr== 127.0.0.1 - Display all IP packets whose source or
destination is localhost.

. tcp.len < 100 - Display all TCP packets whose data length is
less than 100 bytes.

http.request.uri matches “(gif)$” - Display all HTTP requests
in which the uri ends with “gif”.

. dns.query.name == “www.google.com” - Display all DNS
queries for “www.google.com”.



http://www.google.com/
http://www.google.com/

Exercises



Exercise 1: Basic Packet Capture and Analysis

Objective: Learn to capture network traffic and understand packet structures.

1. Step 1: Open Wireshark and start a packet capture on the network interface that has
internet connectivity.

2. Step 2: Browse to a website (e.g., http://example.com) to generate some traffic.

3. Step 3: Stop the capture after the page fully loads.

Tasks:
* Filter HTTP packets and identify the GET request for the page.
* Analyze the TCP 3-way handshake (SYN, SYN-ACK, ACK) for the connection.
* Find the server’s IP address and the port used for the HTTP service.

* Take a screenshot of the packet structure and identify fields such as the source and
destination IP addresses, source and destination ports, and sequence numbers.


http://example.com/

Exercise 2: Analyzing DNS Requests

Objective: Understand how DNS requests are handled in network communication.

=

Step 1: Clear your DNS cache to ensure all DNS requests are fresh.

2. Step 2: Start Wireshark and begin capturing on your active network interface.

3. Step 3: In a browser, visit several websites (e.g., open Google, Yahoo, etc.) and then
stop the capture.

« Use a filter to isolate DNS traffic (dns in the filter).

« Identify at least one DNS query for each website and find the corresponding response.

* Note the response time and TTL (time-to-live) for each DNS query.

« Examine the DNS response and identify if any DNS queries returned multiple IP
addresses.



Exercise 3: Monitoring HTTP and HTTPS Traffic

Objective: Differentiate between HTTP and HTTPS traffic and understand how encryption affects
packet analysis.

1. Step 1: Start capturing packets in Wireshark on your network interface.

2. Step 2: In a browser, visit a website that uses HTTP (e.g., http://neverssl.com) and
another that uses HTTPS (e.g., https://example.com).

3. Step 3: Stop the capture.

e Use a filter to view only HTTP and HTTPS packets.

* Compare the packets from the HTTP and HTTPS connections. Note which fields are
visible and inspectable in HTTP vs. HTTPS.

* |dentify any unencrypted data in the HTTP packets, such as the contents of the GET
requests.

e Try to locate the TLS handshake in the HTTPS packets. Identify fields such as the
ServerHello and Certificate messages.


http://neverssl.com/
https://example.com/
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